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نویسندهي کدام اثر در برابر آن، درست مطرح نشده است؟

2) قصص قرآن – ابوبکر عتیق نیشابوري 1) اسرارالتوحید-ابوسعید ابی الخیر

4) سیاست نامه – خواجه نظام الملک 3) قصصالانبیاء – ابواسحاق نیشابوري

شاعر در کدام بیت از بلبل و آواز خوانی آن، سخن گفته است؟

1) بــاغ دیبـــــا رخ پرند ســـلب *** لعبگر گشت و لعبهاش عجب

2) بوستان گشت چون ستبرق سبز *** آسمان گشت چون کبود قصب

3) بیرم سبـــز برفکـــنده بلنـــد *** شاخ او کرده بسدین مشجب

4) هر گــلی را به شاخ گلبــن بر *** زندبافی است با هزار شغب

شاعر در همهي بیتهاي زیر، غیر از بیت ... از تیرگی شبانه سخن گفته است.

1) هر آنگه که برزد یکی باد سرد *** چو زنگی برانگیخت زانگشت گرد

2) چنان گشت باغ و لب جویبـار *** کجا موج خیزد ز دریاي قار

3) چو پـولاد زنگار خورده سپـهر *** تو گفتی به قیر اندر اندوده چهر

4) نه آواي مــرغ و نه هـرّاي دد *** زمانه زبان بسته از نیک و بد

در همهي بیتهاي زیر، به غیر از بیت ... به برف قلهي کوه اشاره شده است.

1) از سیم به سر یکی کلّه خود *** زاهن به میان یکی کمربند

2) تو مشت درشت روزگــاري *** از گردش قرنها پس افکند

3) تــا درد و ورم فـرو نشیــند *** کافور بر آن ضماد کردند

4) برکش ز سر این سپید معجر *** بنشین به یکی کبود اورند
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زبان و ادبیات فارسی
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4) علم و آگاهی

در مصراع «و را در جهان هوش بر دست کیست ...» هوش به چه معنی است؟

3) میل و علاقه 2) مرگ 3) اندیشه

معنی واژه هاي «شیم، استلام - عنا» به ترتیب، کدام است؟2.

2) درود فرستادن – اندیشهها – گردن کشی 1) سرزنش – بوي ها – سپاس

4) سربرآوردن – سنگهاي قیمتی - مبل 3) خوي ها – بوسیدن – رنج

شاعر در کدام بیت، از ماه و ستارگان اطراف آن در آسمان، سخن گفته است؟7.

1) بنگر به ستـاره که بتـازد سپــس دیو *** چون زر گدازنده که بر قیر چکانیش



1) نه مر خویشتن را فزونـــی نهــد *** نه یکباره تن در مذلّت دهد

2) درشتــی نگــیرد خردمنــد پیش *** نه سستی که ناقص کند قدر خویش

3) درست است پاسخ ولیکن درشت *** درستی درشتی نماید نخست

4) درشتی و نرمی به هم در به است *** چو قاصد که جراح و مرهم نه است

در متن «این صفات که در باطن تو جمع کرده اند، بعضی صفات سطوران و بعضی صـفات دده گـان، و بعضـی

صفات دیوان و بعضی صفات فرشتگان است. طلب آن کن تا بدانی که این صـفات بهـایم و سـباع را در تـو از

اند تا تو را سیر کنند و شب و روز سخره گیرند در سفري که تـرا اند؟ ایشان را براي آن آفریده براي چه آفریده

فرا پیش نهاده اند، از یکی مرکب خویش سازي و از دیگري سلاح خویش سازي حقیقت تـو آن معنـی بـاطن

است و هر چه جز آن است، تبع وي است.»

4) دو 3) سه 2) چهار 1) پنج

«به وقت ادراك خواجه به نظارهي کشت آمد، فراضیعتی رسید» یعنی، ...

1) هنگامی که خواجه سرحال بود به سرکشی محصول آمد، به مخروبه اي رسید.

2) هنگام رسیدن محصول، خواجه به تماشاي محصول آمد، به کشتزاري رسید.

3) در زمان کاشتن زمین، خواجه به بازدید آن آمد، به آب و زمینی رسید.

4) به وقت جمع کردن محصول، خواجه به تماشاي مزرعه آمد، به ویرانه اي رسید.
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2) خورشید بپــوشد زغمش پیــرهن خز *** این است همیشه سلبِ خوب خزانیش

3) کهسار که چون رزمه ي بزّاز بد اکنون *** گر بنگري از کلبهي نداف ندانیش

4) بر مفرش پیروزه به شب شاه حبش را *** از سوده و پاکیزه بلور است اوانیش

همهي ابیات زیر، غیر از بیت ... با عبارت زیر، تناسب معنایی دارند.8.

خشم بیش از حد گرفتن وحشت آرد و لطف بی وقت هیبت ببرد، نه چندان درشتی کن که از تو سیر گردنـد

و نه چندان نرمی که بر تو دلیر شوند.

«مردم آنجا می گفتند هرگز بدین شهر هشت من نان کمتر به یک درم کس ندیده است» یعنی، مـردم آنجـا11.

میگفتند هرگز بدین شهر، کسی ندیده است که

1) به یک درم، بیشتر از هشت من نان بدهند.

2) هشت من نان را به کمتر از یک درم بدهند.

3) به یک درم کمتر از هشت نان بدهند.

4) به کمتر از یک درم، بیشتر از هشت من نان بدهند.
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مضمون کدام بیت، لحظهي طلوع خورشید را بیان میکند؟

1) نـه رسم ارم نه اسم شــداد *** گل بت زبان ژاژ خایی

2) وز سنبل و ســوري سپرغم *** آفاق، نگارخانهي چین

3) بگشــود گره ز زلــف زرتار *** محبوبهي نیلگون عماري

4) اي مونس یوسف اندرین بند *** تعبیر عیان چون شد ترا خواب

بیت «سوزن ما دوخت، هر جا هر چه دوخت زآتش ما سوخت، هر شمعی که سوخت» با همهي ابیات زیر، بـه

غیر از بیت ... تناسب موضوع و محتوا دارد.

1) ما بخوانیــم ار چـه ما را رد کنــند *** عیب پوشیها کنیم ار بد کنند

2) ما به دریا حکم طوفـان میدهیم *** ما به سیل و موج فرمان میدهیم

3) نقش هستی، نقشی از ایوان ماست *** خاك و باد و آب، سرگردان ماست

4) رودها از خـود نه طغیــان میکنند *** آنچه میگوییم ما، آن میکنند

کدام بیت میتواند یادآور سرگذشت حسین منصور حلّاج باشد؟

1) گفـت آن یار کز و گشـــت سرِ دار بلنــد *** جرمش این بود که اسرار هویدا میکرد

2) این همه شعبدهها عقل که میکرد اینجا *** سامري پیش عصا و ید بیضا میکرد

3) بی دلی در همــه احـــوال خدا با او بــود *** او نمی دیدش و از دور خدایا میکرد

4) گوهري کز صدف کون و مکان بیرون است *** طلب از گمشدگان لب دریا میکرد
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پدید آورندگان آثار «سوانح العشّاق – مرصادالعباد – جوامع الحکایات – کیمیاي سعادت» در کدام گزینه، بـه12.

ترتیب نام برده شدهاند؟

1) ابو حامد غزالی – شیخ نجم الدین رازي – سدید الدین محمد عوفی – احمد غزالی

2) احمد غزالی – شیخ نجم الدین رازي – سدید الدین محمد عوفی – ابو حامد غزالی

3) احمد غزالی – سدید الدین محمد عوفی – شیخ نجم الدین رازي – ابوحامد غزالی

4) ابوحامد غزالی – سدید الدین محمد عوفی – شیخ نجم الدین رازي – احمد غزالی

در همهي بیتها به غیر از بیت ... آرایه تشبیه مشهود است.16.

1) از تنــور خودپسندي شد بلنــد *** شعلهي کردارهاي ناپسند

2) پشّه اي را حکم فرمودم که خیز *** خاکش اندر دیدهي خود بین بریز

3) برق عجب آتش بسی افروخــته *** وز شراري خانمانها سوخته

4) رهنمون گشتند در تیه ضــلال *** توشهها بردند از وزر و وبال



1) اگر کسی از لیلی بدگویی کند انگار که به من مدح و آفرین میگوید.

2) اگر کسی مرا ناسزا گوید، مثل آن است که به لیلی ناسزا میگوید.

3) اگر کسی به لیلی سخنی ناروا گوید انگار که به من ناسزا میگوید.

4) اگر لیلی مرا ناسزا گوید، همچون مدح و آفرین برایم گوارا و خوشایند است.

سفارش اصلی حکایت زیر، کدام است؟

بـــوسعــید مهنه در حمــام بــود *** قایمش افتاد و مرد خام بود

شــوخ شیـــخ آورد تـا بــازوي او *** جمع کرد آن جمله پیش روي او

شیخ را گفتار بگو اي پــاك جــان *** تا جوانمردي چه باشد در جهان

شیخ گفتار شوخ پنهان کردن است *** پیش چشم خلق نا آوردن ست...

4) عصمت و بی گناهی 3) نرم و ملایمت 2) عیب پوشی 1) احترام متقابل

شاعر در کدام بیت، حسابرسیِ رستاخیز را یادآوري کرده است؟

1) الهامش از جلیل و پیامش ز جبرئیــل *** رایش نه از طبیعت و نطقش نه از هوي

2) در نعت او زبـان فصاحت که را رســد *** خود پیش آفتاب چه پرتو دهد سها

3) یارب به لطف خویش گناهان ما بپوش *** روزي که رازها فتد از پرده برملا

4) خاصان حق همیشه بلیت کشیدهاند *** هم بیشتر عنایت و هم بیشتر عنا

در متن زیر، املاي کدام کلمه غلط است؟

«اگر در سخن او معنی غامض افتد، در بیان آن به مثال هاي واضح جهت کند و الّا شرط ایجـاز نگـاه دارد و

قلق و ضجرت ننماید و فحش و شطم بر لفظ نگیرد و از مخاطبه ي عوام و کودکان و دیوانگان و مسـتان تـا

تواند احتراز کند و حرکات و اقوال و افعال هیچ کس را به قبح محاکات نکند و سخنهاي موحش نگوید.»

4) احتراز 3) ضجرت 2) غامض 1) شطم
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در عبارت «... درخت بسیار از بیخ کنده میآورد و مغافصه در رسید» معنیِ «مغافصه» چیست؟17.

4) با سر و صدا و هیاهو 3) به تندي و شتاب 2) به آرامی 1) ناگهانی

معنی مصراع پایانی دو بیت زیر، چیست؟18.

گفت مجنون گر همه روي زمین *** هر زمان بر من کنندي آفرین

من نخــواهم آفرین هیچ کــس *** مدح من دشنام لیلی باد و بس

متن «وي از شعراي معروف قرن دوازدهم هجري است. منظومه ي به نام یوسف و زلیخا به تقلیـد از یوسـف و22.

زلیخاي جامی دارد. در قصیده و غزل و ترانه بر روش شعراي قدیم پارسی گوي اقتفا کـرده و در ایـن میـدان
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شاعر در همهي بیتهاي زیر، به غیر از بیت ... فضایل حضرت علی (ع) را بر شمرده است.

1) آن را که در رکوع غنی کرد بی سؤال *** درویش را به پیش پیمبر سخاوتش

2) آن ا که مصطفی چو همه عاجز آمدند *** در حرب روز بدر بدو داد رایتش

3) در بود مر مدینهي علــم رســول را *** زیرا جز او نبود سزاي امانتش

4) تا در دلم قرآن مبــارك قــرار یافت *** پر برکت است و خیر، دل از خیر و برکتش

بیت «از در افتادن شکاري خام *** صد دیگر در اوفتند به دام» با کدام بیت تناسب مفهومی دارد؟

1) عیب یک همنشست باشــد بس *** کافکند نام زشت بر هر کس

2) رقص مرکب مبین که رهوارست *** راه بین تا چگونه دشوارست

3) اي با تیــز طبــع کاهل کــوش *** که شد از کاهلی سفال فروش

4) وانــکه دانـش نباشــدش روزي *** ننگ دارد ز دانش آموزي

بیت «چو گوهر برآمود زندگی به تاج *** شه چین فرود آمد از تخت عاج» با کدام یک از ابیات زیر تناسـب

معنایی دارد؟

1) دگر روز کاین روي شسته ترنــج *** چو ریحانیان سر برون زد ز کنج

2) ز درج شَبه سر چو شب باز کـرد *** به پیرایه پیوستن آغاز کرد

3) سپیده چو شب را به بر در گرفت *** شبش کرد بدرود و ره برگرفت

4) چو برگشت شب گرد کرده عنان *** سپیده برآورد رخشان سنان

معارف اسلامی
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موفق بوده است تذکرهي آتشکدهي او از جملهي منابع مهم تحقیق در احوال شعرا تا زمان او بده اسـت کـدام

شاعر را معرقی میکند؟

4) اهلی شیرازي 3) آذر بیگدلی 2) هاتف اصفهانی 1) مشتاق

انسان نمازگزار به منظور درك ثواب نماز جماعت، نیت میکند و به اندیشهي این کـه امـام را در رکـوع درك26.

کند به رکوع میرود، پس از رفتن به رکوع، شک میکند که آیا امام را درك کرده یا نه، نمـازش چـه حکمـی

دارد؟

2) به صورت فرادي صحیح است. 1) باطل است.

4) به صورت جماعت صحیح است. 3) باید نمازش را اعاده کند.
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نماز دو رکعتی که هر رکعت آن پنج رکوع دارد و نماز دو رکعتی که رکعت نخسـت آن 5 قنـوت دارد و نمـاز

دو رکعتی که هر رکعتش قنوت دارد به ترتیب، نماز ... و ... و ... است.

2) آیات - جمعه – عبدین 1) آیات – عبدین – جمعه

4) عبدین – آیات - جمعه 3) عبدین – جمعه – آیات

هرگاه انسان مکلف غیر مجتهد در غیر ضروریات دین، از عبادات و مستحبات، بدون تقلید تکلیفـی از تکـالیف

دین را انجام دهد تکالیف انجام شده در صورتی صحیح است که ... باشد.

2) مبتنی بر حکم االله واقعی 1) مبتنی بر عمل به احتیاط

4) موافق با فتواي یکی از مراجع زنده 3) موافق با فتواي مرجع اعلم

مفهوم آیهي شریفهي : «االله یصطَفی من الملائکه رسلاً» این است که ...

1) پیامبران، برگزیدگان فرشته خوي خداوند میباشند.

2) انتخاب خداوند از فرشتگان، یک اصطفاي تکوینی است.

3) گروهی از فرشتگان، پیامرسانان برگزیدهي خداوند میباشند.

4) رسالت خداوند، بر دوش پیامبران فرشته صفت نهاده میشود.

از دقت در آیهي شریفهي : «و ما منّا الّا له مقام معلوم» موضوع ... مفهوم میگردد.

2) ذو مراتب بودن فرشتگان 1) وحدت هستی و وجود

4) شدت و ضعف داشتن وجود 3) ذو مراتب بودن کاینات
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4) واجب - است

پاسخ سلام در حین گزاردن نماز، ... و عدم آن، عمداً موجب بطلان نماز ...

3) مستحب – نیست 2) واجب - نیست 1) مستحب – است

تقدیم و تأخیر در واجبات غیر رکن نماز، عمداً و سهواً و تقدیم و تأخیر در واجبات رکنی نماز سهواً به ترتیب،28.

نماز چه وصفی به خود میگیرد؟

2) صحیح – باطل - صحیح 1) صحیح – صحیح – باطل

4) باطل – صحیح - باطل 3) باطل – صحیح – صحیح

مفهوم بیت : «گر چه دیوار افکند سایه دراز *** بازگردد سوي او آن سایه باز» در همه ي موارد به جز مـورد33.

... به چشم میخورد.

2) فمن یعمل مثقال ذره خیراً یرَه 1) هل تُجزون الّا ما کنتم تعملون

4) و ما تُقَدموا لأنفسکم من خیر تجدوه عنداالله 3) و اذا نُفخ فیه اُخري فاذاهم قیام ینظرون



.36

.37

.38

از دقت در آیهي شریفهي : «االله یتَوفَی الانفس حین موِتها و الَّتی لَـم تُمـت فَـی منامهـا» موضـوع ... مفهـوم

میگردد.

1) فاعلیت مستقل خداوند به انجام توفی

2) فاعلیت مستقل خداوند به اعطاي جزاء و پاداش

3) توفی و قطع ارتباط تمام و کمال به هنگام مرگ و خواب

4) عدل جزائی خداوند به تمام و کمال پاداش دادن اعمال

پیام آیهي شریفهي : «اَلالَه الخَلقُ و الأمرُ» اعلان ... میباشد.

1) اختصاص «خلق» به ذات باري تعالی و «امر» به مکلّفان

2) قبول بندگی در پذیرش خالقیت و آمریت خداوند

3) دو بعدي بودن انسان و تعلق بعد غیر مادي او به عالم «امر»

4) دو بعدي بودن انسان و تعلق بعد مادي او به عالم «امر»

پیام این کلام امیر مؤمنان – علی علیهالسلام که میفرماید: «لم یسکنوا الاصلاب و لم یغتَنمـوا الأرحـام و لـم

یخلقُوا من ماء مهینٍ» کدام مورد است؟

1) فرشتگان، ماهیتی مغایر با انسان و دیگر مخلوقات ذيشعور دارند.

2) انبیاء، برگزیدگان نیالوده به دامان ناپاك پدران و مادرانند.

3) فرشتگان معصوم از نافرمانی خداوند و برخوردار از مقام تجردند.

4) امامان برگزیدگان نیالوده به دامان ناپاك پدران و مادرانند.
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حدوث وقایعی عظیم، ناگهانی و غیر قابل پیش بینی در جهان و ظهور انقلابـی بـزرگ در کاینـات از رخ داده34.

هاي ...

2) پیش از رستاخیز، پس از نفخ صور دوم 1) پیش از رستاخیز، پس از نفخ صور اول

4) پس از رستاخیز، پس از نفخ صور دوم 3) پس از رستاخیز، پس از نفخ صور اول

پیام آیهي شریفهي : «اَفَحسبتم اَنَما خلقناکم عبثاً و انّکم الَینا لا ترجعون» اثبات ...35.

2) امکان معاد با توجه به عدالت پروردگار 1) ضرورت معاد با توجه به عدالت پروردگار

4) ضرورت معاد با توجه به حکیمانه بودن خلقت 3) امکان معاد با توجه به حکیمانه بودن خلقت

پیام آیهي شریفهي : «فلا اُقسم بما تُبصرون و مالا تُبصرون» با کدام مورد، مناسبت معنایی دارد؟39.

1) کوه و دریا و درختان، همه در تسبیح اند – نه همهه مستمعی فهم کند این اسرار

2) در سبب ساریش من سوداییم – وز سبب سوزیش سوفسطاییم



.41

.42

.43

پیام آیه ي شریفه ي : «حبب الیکم الأیمان و زینه فی قلوبکم و کَره الیکم الکفَر و الفسوق و العصـیان گـرایش

ذاتی انسان به ... است و امانت نهاده شده بر دوش انسان، به بیان اکثر مفسران همان ... میباشد.

1) تقدیس – احراز مقام خلیفه اللّهی او

2) دانایی – احراز مقام خلیفه اللّهی او

3) زیبایی – قبول مسوولیت گزینشهاي اختیاري او

4) اخلاق – قبول مسوولیت گزینشهاي اختیاري او

اهمال نورزیدن در وضع و جعل تکالیف موصل به سعادت و عدم تضییع قابلیت موجودات در اعطـاي مواهـب،

به ترتیب، کدام است و پیام آیهي شریفهي : «و ما کُنّا معذّبِین حتّی نَبعت رسولاً» چیست؟

2) عدل تکوینی – عدل جزائی – عدل تشریعی 1) عدل تشریعی – عدل جزائی – عدل تکوینی

4) عدل تکوینی – عدل تشریعی – عدل جزائی 3) عدل تشریعی – عدل تکوینی – عدل جزائی

آن گاه که افعال فاعل در غایت استواري و کمال و به دور از هر گونه نقصانی، مطرح شود، آن فاعـل موصـوف

به ... است که لازمهاش، نظام ... میباشد.

2) قدیر – اَتقن و احَسن 1) حکیم – اَتقن و احَسن

4) حکیم – مقدر و غایت مند 3) قدیر – مقدر و غایت مند
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3) جهان چون چشم و خال و خط و ابروست – که هر چیزي به جاي خویش نیکوست

4) چرخ با این اختران نغز و خوش و زیباستی – صورتی در زیر دارد آنچه در بالاستی

کدام مورد مبین اصل عمومیت ارادهي الهی است و چه چیز متعلّق ارادهي الهی قرار میگیرد؟40.

1) انّما امره اذا اراد شیئاً یقولِ له کُن فیکون – هر معلولی از علت مباشر و با حفظ تمام خصوصیات آن

2) انّما امره اذا اراد شیئاً یقولِ له کُن فیکون – وقوع فعل به صورت مطلق و خالی از خصوصیات آن

3) و نَبلوکم بالشّر الخَیر فتنه و الینا تُرجعون – هر معلولی از علت مباشر و با حفظ تمام خصوصیات آن

4) و نَبلوکم بالشّر الخَیر فتنه و الینا تُرجعون – وقوع فعل به صورت مطلب و خالی از خصوصیات آن

امري که فی حد نفسه، ممتنع نباشد، اما تحقّق آن، به اجتماع نقیضین بینجامد، محـال ... کـه لیاقـت تعلّـق44.

قدرت غیر محدود خداوند را ...

4) عادي - دارد 3) ذاتی – ندارد 2) وقوعی – ندارد 1) وقوعی – دارد

با توجه به مضامین قرآنی و روایی، تفاوت معانی اوصاف الهی با معانی اوصاف موجودات دیگر به معنـاي فهـم45.

ناپذیري اوصاف الهی ... که مفهوم عبارت ... دال بر آن است.

2) است – لم یحجبها عن واجب معرفته 1) نیست – لم یحجبها عن واجب معرفته



.47

.48

.49

آن گاه که غوطهور شدن در مشاهدهي مخلوقات الهی یا پـرداختن بـه احتجـاج و اسـتدلال، مـانع وصـال بـه

محبوب تلقی شود، از راه ... حمایت شده است که مصداقش عبارت ... میباشد.

1) استدلال یا عقل – آیا هیچ موجودي غیر از تو ظهوري دارد.

2) دل با فطرت – آیا هیچ موجودي غیر از تو ظهوري دارد.

3) استدلال یا عقل – مسلماً در آفرینش آسمانها و زمین، نشانه هاي خداشناسی است.

4) دل یا فطرت – مسلماً در آفرینش آسمانها و زمین، نشانه هاي خداشناسی است.

هر یک از مفاهیم «خدایابی» و «خداشناسی» به ترتیب، با کدام مصـداق هـم سـویی دارنـد و جـدا کننـدهي

انسان از صف ملحدان و شکّاکان چیست؟

1) شناخت اوصاف و افعال خداوند – شناخت وجود خداوند – خدایابی

2) شناخت اوصاف و افعال خداوند – شناخت وجود خداوند - خداشناسی

3) شناخت وجود خداوند – شناخت اوصاف و افعال خداوند – خدایابی

4) شناخت وجود خداوند – شناخت اوصاف و افعال خداوند - خداشناسی

متعالیترین اشکال حیرت، به چه افرادي اختصاص دارد و راه رهایی از گردباد تحیر، کدام است؟

1) به پیامبران و عارفان – تسلیم در برابر عقلانیت

2) به گرفتاران به چنگال شکّاکیت – تسلیم در برابر عقلانیت

3) به پیامبران و عارفان – ایمان و یقین به حقایق ماوراي طبیعی

4) به گرفتاران به چنگال شکّاکیت – ایمان و یقین به حقایق ماوراي طبیعی
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4) است – لم یطلع العقولَ علی تحدید صفته 3) نیست – لم یطلع العقولَ علی تحدید صفته

پیام آیهي شریفهي: «یا ایها النّاس انتم الفقراء الی االله و االله هو الغنی الحمید» ... میباشد.46.

2) وجود مقدم بر وجوب 1) وجوب مقدم بر وجود

4) وابستگی وجودي ممکنات به واجبالوجود 3) ضرورت سنخیت بین علت و معلول

بنیان گذار عقل گرایی، در اروپاي قرن هفدهم که بود و فلسفهي او موصوف بـه چـه وصـفی شـد و هـدف او،50.

حمایت از چه چیز بود؟

1) دکارت – نقّاد – از عقل عملی

2) دکارت – نقّاد – از عقل نظري

3) کانت – عقلانیت – از عقل نظري

4) کانت – عقلانیت – از عقل عملی



.52

.53

.54

.55

.56

.57

چنانچه متحرك A به اندازه 20 کیلومتر به سمت شمال از نقطه O دور شود، سپس به اندازه 15 کیلومتر بـه

طرف غرب حرکت نماید، فاصله متحرك A از نقطه O چقدر خواهد بود؟

4) 20 کیلومتر 3) 35 کیلومتر 2) 25 کیلومتر 1) 15 کیلومتر

کدام کلمه در مقایسه با سایر کلمات نامتجانس است؟

AGENT, BALL, CHAIR, FRANCE, DOOR

FRANCE (4 BALL (3 CHAIR (2 DOOR (1

چه حروفی به جاي علامت سؤال میتوان گذاشت؟

G – 4) پ F – 3) پ G – 2) ب F – 1) ب

یک دوچرخه سوار با سرعت 50 کیلومتر در ساعت و یک موتور سوار با سرعت 80 کیلومتر در ساعت به یـک

سمت میروند. از لحظه اي که موتور سوار 35 کیلومتر از دوچرخه سوار عقبتر است تا وقتی که فاصله صـفر

شود چند دقیقه طول میکشد؟

4) 80 دقیقه 3) 70 دقیقه 2) 60 دقیقه 1) 50 دقیقه

بیست درصد دوازده، چند درصد چهار است؟

80 (4 4 (3 50 (2 60 (1

اگر چهار کارگر، چهار ساختمان را در چهار هفته نظافت نمایند براي نظافت هشت ساختمان در هشت هفتـه

چند کارگر نیاز است؟

8 (4 6 (3 4 (2 2 (1
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هوش

.51

4) گ 3) ك

به جاي علامت سؤال چه حرفی را باید گذاشت؟

Ä پ Ä چ Ä ر Ä ض ؟

2) ق 1) ف

چهار عدد (1، 3، 5، 7) را در نظر بگیرید. با استفاده از این اعداد چند عدد چهار رقمی مـیتـوان سـاخت کـه58.

رقم آن تکراري نباشد؟

16 (4 32 (3 24 (2 20 (1



.60

.61

.62

.63

.64

.65

به جاي علامت سؤال چه عددي باید گذاشته شود؟

؟ و 60 و 100 و 180 و 340

40 (4 30 (3 20 (2 10 (1

راهنمایی: در سؤالات 61 تا 65، در بین تصاویر داده شده، یک تصویر با بقیه تفاوت دارد. آن را پیدا کرد.

3 (2 2 (14 (3

5 (3

5 (3

5 (3

4 (3

5 (4

6 (4

6 (4

4 (4

6 (4

3 (2 2 (1

3 (2 1 (1

1 (2 3 (1

3 (2 1 (1
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در یک کیسه برزنتی پنج گوي زرد، شش گوش سبز و هشت گوي سفید وجـود دارد. بـدون نگـاه کـردن بـه59.

داخل کیسه، چند گوي باید بر داریم که حتماً یک گوي سبز داشته باشیم؟

19 (4 14 (3 12 (2 9 (1



راهنمایی : در هر یک از سؤالات 16 تا 20، شکل سمت راست تصویر گستردهي یکی از اشکال سمت چپ اسـت. آن

را پیدا کنید و در پاسخ نامه علامت بزنید:

.66

.67

.68

.69

.71

.72

.73

.74

؟ .70

راهنمایی: در هر یک از سؤالات 71 تا 75، از چرخش شکل سمت راست در جهت فلش به انـدازه 90 درجـه، کـدام

یک از اشکال سمت چپ نتیجه میشود؟ آن را پیدا کنید و در پاسخنامه علامت بزنید:

12سئوالات آزمون استخدامی بانک تجارت سال 1387



.76

.77

.78

.79

.80

.81

.82

بنیانگذار بانک شاهی در ایران کیست؟

1) سرجان ملکم

3) ژولیوس بارون دورویتر

اولین رئیس مجلس شوراي اسلامی کدام یک از شخصیتهاي زیر بوده است؟

3) کروبی 2) هاشمی رفسنجانی 1) مهدوي کنی

کدام یک از شخصیتهاي زیر تاکنون مسئولیت وزارت امور اقتصادي و دارایی را بر عهده نداشته است؟

4) حسینی 3) شیبانی 2) نوربخش 1) مظاهري

موسیقی آواز مذهبی را اصطلاحاً چه میگویند؟

4) کمپوزیتور 3) آرانژمان 2) باریتون 1) انتم

گلبولهاي قرمز در کجا از بین میروند؟

4) قلب 3) معده 2) جگر 1) طحال

آب در چه درجه حرارتی بیشترین جرم مخصوص را دارد؟

4) 4 درجه 3) 100 درجه 2) 50 درجه 1) 125 درجه

از بین افراد زیر کدام یک تاکنون ریاست بانک مرکزي را عهده دار بوده است؟

4) توکلی 3) نوربخش 2) شریعتمداري 1) وهاجی

2) ادوارد براون

4) پروفسور آلدریچ

4) ناطق نوري
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.75

اطلاعات عمومی

.83

4) جیفرماکسول3) پلانک2) ارنست رادرفورد

کاشف هلیوم:

1) پیرفام

.84

4) بطلمیوس

جدول ضرب توسط کدام یک از دانشمندان زیر وضع شد؟

3) جالینوس 2) فیثاغورت 1) اقلیدس

.85

4) تهذیب الاخلاق3) من لایحضر الفقه

کدام یک از کتابهاي زیر از آثار ابوعلی سینا است؟

2) آثارالباقیه 1) اشارات و تنبیهات



.89

.90

.91

.92

.93

.94

بین دانشگاه هاي ذکر شده کدام یک قدمت بیشتري دارد؟

3) دانشگاه پراك 2) دانشگاه هاروارد 1) دانشگاه آکسفورد

کدام یک از دانشمندان زیر ستاره شناس بودند؟

2) ابوزکریا یحیی 1) عیسی بن یحیی

4) علی بن عباس مجوسی 3) ابو عبداالله خوارزمی

نوعی شعر که در آن اشعار متحدالقافیه سروده شده و یک بیت که معمولاً نقطه عطـف مقصـود شـاعر اسـت،

تکرار میگردد چه نامیده میشود؟

4) مثنوي 3) مسدس 2) ترجیع بند 1) مسمط

در قرن هجدهم کدام نهضت ادبی در اروپا پیدا شد؟

4) رئالیسم 3) رومانتیسم 2) ناتورالیسم 1) کلاسیسم

اثر شیمیایی کدام یک از پرتوهاي زیر کمتر است؟

4) اشعهي قرمز 3) اشعهي لیزر 2) اشعهي ماوراء بنفش 1) اشعه مادون قرمز

کدام یک از نمکهاي زیر در حالت محلولی سبز رنگ است؟

4) کلرور پتاسیم 3) نیترات باریم 2) سولفات نیکل 1) سولفات روي

4) دانشگاه بال
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.86

4) سوپویور3) بالکان

کدام یک از دریاچه هاي زیر در آفریقا واقع است؟

2) آرال 1) ویکتوریا

.87

4) شرق کانادا3) شمال ترکیه

خلیج «تارانتو» در کجا واقع است؟

2) جنوب ایتالیا 1) غرب مکزیک

کدام یک از سبکهاي زیر قدیمیتر است؟88.

1) سبک ترکستانی و خراسانی

3) سبک عراقی

2) سبک هندي

4) سبک بازگشت ادبی

.95

4) 12 فرمان3) 9 فرمان

اساس دین یهود بر چند فرمان منقوش است؟

2) 10 فرمان 1) 8 فرمان

.96

4) شاپور ذوالکتاف

در زمان تولید عیسی (ع) کدام پادشاه در ایران سلطنت میکرد؟

3) اردشیر بابکان 2) مهرداد اول 1) فرهاد پنجم



کاشف اشعهي مجهول X کیست؟100.

2) هاندي بکدل 1) دانیل بویل

ICDL مهارتهاي رایانه

101. کدام یک از موارد زیر یک نرم افزار نیست؟

office (2 1) سیستم عامل

MB 50 .102 چند کیلو بایت است؟

5×104 (2 512×102 (1

103. کدام یک از موارد زیر جزو چهار آیکون اصلی Desktop نیستند؟

Internet Explorer (2 My Computer (1

Show Desktop (4 My Network Places (3

Quick launch .104 در کدام قسمت قرار دارد؟

3) نوار منو 2) نوار عنوان 1) نوار وضعیت

3) ویلیام هاروي

Acrobat Reader (3

512×103 (3

4) ویلهم کُنرادفن رونتگن

modem (4

500×103 (4

4) نوار وظیفه
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.97

4) استفن تسوایک3) آندره ژید

کدام یک از نویسندگان زیر بیوگرافی نویس است؟

2) ژان ژاك روسو 1) آرنولد توین بی

.98

4) مساوي است3) در استوا

وزن اجسام در قطب بیشتر است یا در استوا؟

2) در قطب 1) فرقی ندارد

بزرگترین نقاش سورآلیست جهان کیست؟99.

1) پابلو پیکاسو اسپانیایی

3) سالوادور دالی اسپانیایی

2) آلبرت دورر آلمانی

4) سانتی رافائل ایتالیایی

105. پسوند برنامه Paint چیست؟

gif (2 JPG (1tif (3bmp (4

106. براي وارد شدن به start up سیستم از منوي Run از چه دستوري استفاده میکنیم؟

4) هیچ کدام temp% % (3 ms config (2 reg edit (1



براي وارد کردن شماره صفحه:108.

Insert→Header & footer (1

Insert→Page numbers (3

109. براي استفاده از کادر دور صفحه (بردارهاي صفحه) کدام یک از موارد زیر صحیح است؟

Insert→Borders & shading→Borders (1

Insert→Borders & shading →Page Borders (2

Format→Borders & shading→Borders (3

Format→Borders & shading→Page Borders (4

110. کدام یک از انواع پارگراف نیست؟

Align Right (4 Handging (3 first Line (2 None (1

111. تعداد سطر و ستونهاي برنامه Excel چند تا است؟

4) 1024 و 2048 3) 30000 و 1024 2) بی نهایت و 300 1) 65536 و 256

112. نام پیش فرض یک فایل Excel چیست؟

doc 1 (4 Test 1 (3 Book 1 (2 Excel (1

113. با انتخاب کدام گزینه اندازه متن طوري تغییر میکند که حتماً در یک خانه جا شود؟

split cells (4 Merge cells (3 shrink to fit (2 wrap text (1

format→Page numbers (2

Edit→Page numbers (4
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107. براي اینکه اعداد در برنامه word فقط انگلیسی تایپ شوند (در حالیکه تنظیمات زبان در سیستم هـم بـراي

فارسی، هم براي انگلیسی انجام شده است) کدام گزینه را انتخاب میکنید؟

tools→options→complex script→numeral→system (1

tools→options→complex script→numeral→Arabic (2

tools→options→complex script→numeral→Hindi (3

tools→options→complex script→numeral→context (4

= MID (3 , 4 ,"3478910") 114. خروجی تابع روبرو چیست؟

87 (3 7891 (2 891 (178 (4

115. به کمک کدام گزینه در پاورپوینت میتوان در حالت نمایش Slide show کلیک راست را غیر فعال کرد؟

Full Screen brows at a kiosk (2 browsed by an individual windows (1

show without Animation (4 show without narration (3



117. هدف از گزینه Slide transition چیست؟

1) حرکت عناصر اسلاید

2) حرکت پس زمینه اسلاید

3) جابهجایی بین اسلایدها

Slide show 4) حرکت اتوماتیک تمامی اسلایدها در

118. براي اینکه عناصر موجود در یک اسلاید بصورت اتوماتیک پشت سر هـم نمـایش داده شـوند بایـد ... انتخـاب

شود:

on click (4 with previous (3 with next (2 After previous (1

119. همه از انواع Relation ship بین جداول اکسس هستند بجز:

4) یک به یک 3) چند به چند 2) یک به چند 1) یک به دو

120. کدام گزینه براي استخراج اطلاعات و کدام براي دریافت و نگهداري اطلاعات به کار میروند؟

Form - Query (4 Table - Query (3 Query - Table (2 Table-Report (1

121. چگونه میتوان مشخصات (Properties) یک عنصر را در فرم به کمک صفحه کلید مشاهده کرد؟

F4 (4 F3 (3 F2 (2 F10 (1

122. پسوند فایلهاي Access به صورت پیش فرض چیست؟

BDM (4 MDB (3 DMB (2 MDP (1

123. کدام مورد یک برنامه مرورگر WEB نیست؟

firewall (4 Netscape (3 opera (2 fire fox (1
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116. نام پیش فرض فایلها در پاورپوینت و پسوند آنها به ترتیب عبارتند از:

PPS-PPt (2 PPT-work book (1

PPS-presentation (4 PPt-presentation (3

124. براي اینکه در زمان Disconnect بتوانیم صفحات سایت هاي اینترنتی را که قبلاً مشاهده نموده ایم، ببینـیم

از کدام مورد استفاده میکنیم؟

favorites 2) فعال کردن History 1) فعال کردن

4) هیچ کدام Work offline 3) فعال کردن



126. This programs are ……………….. for use on home computers.

1) similar 2) complete 3) suitable 4) comfortable

127. having children is a big ………………….. and I'm not sure I'm ready for that yet.

1) solution 2) procedure 3) employment 4) responsibility

128. I asked the secretary to …………… how I should fill in the form.

1) locat 2) protect 3) receive 4) explain

129. The he main …………… of this meeting is to decide what we should do next.

1) opinion 2) purpose 3) collection 4) statement

130. You must decide for yourself. Don't let anyone else ……………….. you.

1) judge 2) rescue 3) admire 4) influence

131. I’ m feeling tired. I ………… for six hours.

1) Work 2) will work

3) am working 4) have been working

132. The book ………….. is not in the library.

1) I need 2) I need it 3) that I need it 4) which I need it

133. I can't talk to peter. I wish I ……………. How to speak English.

1) Knew 2) know 3) had known 4) have known

134. who is ……….. boy in the class?

1) most intelligent 2) more intelligent

3) the most intelligent 4) more intelligent

18سئوالات آزمون استخدامی بانک تجارت سال 1387

Encoding .125 استاندارد در مرورگرهاي Web کدام است؟

Unicode (UTF-8) (2 Arabic windows (1

4) هر سه مورد User Defined (3

زبان انگلیسی

135. The whole class ……………………

1) the exercises badly did

3) did the exercises badly

2) badly did the exercises

4) did badly the exercises

Leonardo da Vinci is one of the greatest artists of the Italian Renaissance. He (136) ………… at Vinci,

Italy. He studied painting (137) ………….. Florence. The most(138) ………………. Of his paintings is the



Mona Lisa. It (139) ……………….. in the Louver. He Knew the art of making (140) ………….. look nearer

or father away. In fact, he was a master artist.

136.

1) born 2) is born 3) was born 4) had born

137.

1) in 2) on 3) at 4) into

138.

1) useful 2) famous 3) agreeable 4) disappointing

139.

1) hangs 2) stands 3) looks up 4) wonders

140.

1) objects 2) pictures 3) subjects 4) passages

Passage 1:

There are many different types of reading material (books, cards, charts) which schools use in the

teaching of reading. this was not always so as you can see if you turn to the article children’s

Literature. Today there are books at all levels which are both interesting and enjoyable and also

help children to become better readers. Many contain pictures and diagrams designed to help and

encourage the young reader. Often a whole series of books offers a step – by – step development

of reading skills. Each is designed to build on what has been taught in previous books and to

prepare the reader for what follows in later books.

In the past, most text books used for the teaching of reading had a "controlled vocabulary". Each

story in the book used only a small number of words. Because there were so few words (in some

cases as few as 20) , the stories were not very original or intersesting.

141. What is the best title for this passage?

1) teaching reading 2) Reading materials

3) Reading problems 4) The young reader

142. Today, most textbooks ……….

1) contain boring stories

2) help children become good readers

3) have a small number of pictures

4) are out of touch with the modern word

143. The word "Each" in line 10 refers to …………

1) book 2) skill 3) reader 4) development
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145. Which of the following is NOT mentioned as an example of reading materials?

1) charts 2) cards 3) books 4) diagrams

Passage 2:

Normal, healthy people can improve their memories very easily. First of all, learn to relax if you're

trying to memorize something. You may miss important items if your mind is on something else or

if you weren't paying attention because of anxiety – you retain information best when you are

alert and concentrating. If you're having trouble concentrating, increase the flow of oxygenated

blood to the brain. Despite its small size the brain used 20 percent of the body's oxygen

requirement. So try to combine study with exercise, particularly the kind of exercise that gets you

breating faster. Keep your mind fit as well as your body by doing mental workouts. Crosswords,

scrabble and quizzes all help to keep the mind in shape.

146. The passage mainly discusses ………….

1) two ways of remembering 2) how to train your memory

3) why we forget important items 4) short term and long term memory

147. The word it's in line 5 refers to ……………

1) flow 2) blood 3) brain 4) oxygen

148. According to the passage, in order to memorize something, first you sould

……….

1) study hard 2) do puzzles

3) learn to relax 4) improve your memory

149. You may forget important things because you …………….

1) are anxious 2) pay attention

3) breathe very fast 4) are concentrating
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144. According to the passage, stories in old text books were not interesting

because they ……..

1) had a large vocabulary 2) had very few words

3) were designed for adults 4) were designed by teachers

150. All of the following help to keep the mind in shape EXCEPT …………

1) facts 2) quizzes 3) puzzles 4) crosswords
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12

23

31

44

54

62

74

82

94

102

113

122

133

141

151

162

171

184

192

203

211

223

234

241

252

262

274

284

291

304
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313

322

334

341

354

363

373

381

394

403

414

423

431

442

453

464

473

483

493

502

513

522

531

543

554

561

574

582

593

604
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4 61

1 62

4 63

- 64

1 65

4 66

1 67

2 68

1 69

3 70

4 71

2 72

3 73

4 74

4 75

3 76

2 77

3 78

3 79

1 80

4 81

3 82

- 83

2 84

1 85

1 86

2 87

1 88

1 89

3 90
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پاسخنامه
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912

923

931

942

952

961

971

982

993

1004

1014

1021

1034

1044

1054

1062

1072

1083

1094

1104

1111

1122

1132

1141

1152

1163

1174

1181

1191

1203

1214
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1223

1234

1243

1254

1263

1274

1284

1292

1304

1314

1321

1331

1343

1353

1363

1371

1382

1391

1401

1414

1422

1432

1444

1452

1463

1473

1481

1491

1502

22سئوالات آزمون استخدامی بانک تجارت سال 1387


